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Installing CiscoRemote
This section discusses installation improvements for CiscoRemote 1.0.

CD-ROM Installation

To install the CD-ROM version of CiscoRemote, follow these steps:

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6

Load the CiscoRemote CD into your CIDR drive. From the File menu in theikddows
Program Manager, seldRun.

Click Browse from the Run dialog box.

Select the drive that contains the CiscoRemote CD-ROM.
Open the directory called ciscormt.

Open the file called INSTALL.EXE

Click OK from the Run dialog box.

Installation with Network Operating Systems

If you intend to use CiscoRemote with Windows for Workgroups or Novell NetWare, you should
have these networks installed and running before installing CiscoRemote. In some cases, you may
need to set up the network after installing CiscoRemote.

Novell NetWare

CiscoRemote includes the Ml NetWare 4.01 client softare. If you vant to run Neell NetWare
3.11 or earlier, which is not included in CiscoRemote, NetWare must be running during the
CiscoRemote installation.

To install NetWare version 3.11 or earlier, you must manually configure the NetWare installation.
The CiscoRemote installation creates and modifies the configuration and batch files necessary for
the Novell NetWare installation, but it does not copy the NetWare client executable files (for
example, NETX.EXE and LSL.COM) onto the hard disk. To complete the Novell NetWare
installation, follow these steps:

Step 1

Step 2

Windows for Workgroups

Copy the Novell client files into the directory containing NET.CFG.
Refer to the Novell NetWare documentation for related information.

Move STARTNET.BAT, which the CiscoRemote installer added to the end of
AUTOEXEC.BAT, to a location where it will be invoked at boot up time.

For example, if your AUTOEXEC.BAT starts up WIN, make sure STARTNET precedes
WIN.

CiscoRemote automatically configures your network set up files. However, you may need to
manually add a CiscoRemote adapter and protocol if you alter other network connections (for
example, changing an IP address or subnetadd the CiscoRemote PPP/SLIP protocaladrio a
Windows network, follow these steps:

Step 1

Step 2

From a PC that has Windows for Workgroups already installed and running, install
CiscoRemote on your system.

Click on thewindows Setupicon.
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Step 3 From the Options menu in the Network Setup dialog box, s€lehge Network
Settings

Step 4 Click Networks to ensure thdnstall Microsoft Windows Network is selected in the
Network screen. ClicloK.

Step 5 Click Drivers in the Network Setup dialog box.
Step 6 Click Add Adapter in the Network Drivers dialog box.

Step 7 SelectCiscoRemote PPP/SLIP Driverin the Add Netwrk Adapter dialog box and click
OK.

To add the CiscoRemote VxD driver for remote access, follow these steps:

Step 1 Select the CiscoRemote PPP/SLIP driver from the Network Drivers dialog box and click
Add Protocol.

Step2 SelectCiscoRemote VxD (remotejrom the Add Network Protocol dialog box and click
OK. CiscoRemote VxD must be the delt protocol for its adaptelf it isn’t, select it and
click Set As Default Protocol then close the dialog box.

Step 3 Click OK in the Netvark Setup dialog box. If the Setup Microsoft NetkwNames appears,
set up the names as instructed. CiscoRemote is fully installed once you reboot.

Note To save memory, you can remove Microsoft NetBEUI and IPX/SPX Compatible Transport
(with NetBIOS), which are attached to the PPP/SLIP driver in the Network Drivers dialog box.

Selecting Remote Access Protocols
The Protocols Installation dialog box in Release 1.0 is replaced by Figure 1 in Release 1.0 (2).

Figure 1  CiscoRemote Protocols Installation Dialog Box

Select the remote access protocol features yvou wish
to install:

[¥ TCPAP Protocol Stack
[ Include:
@ Microszoft Windows Network Support

) Hovell Netware Suppoit

Preszz OK to zelect the default ingtallation or change the
optionz to meet your particular needs. If pou are unzure of
which optionz to choose. press the Help button or contact
pour network administrator.

M 425

You can select the Transmission Control Protocol/Internet Protocol (TCP/IP) stack and include
support for the network environment that you are using. Support for Windows and NetWare
networking cannot be simultaneously selected. Refer to Table 1 for assistance on deciding which
protocol features to install.
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Table 1 Installation Selections for Your Connection

If Your Networking Environment Needs Check this Protocol Feature
Support for TCP/IP with Winsoainly. TCP/IP Protocol Stac&nly.

Support for Windows networking using NetBIOS over TCP/IP. TCP/IP Protocol Stack and include Microsoft
Windows Network Support.

Support for Novell networking. Novell NetWare Supportly.

Support for the CiscoRemote applicationshatthe TCP/IP Selectonly CiscoRemote applications; don’t
Protocol Stack. select the TCP/IP Protocol Stack or support for an
operating system.

Choosing Applications

The CiscoRemote 1.0 Netscape installation conflicts with .DLL files in some PC systems. For
example, in some cases the installation program will hang or execute a continuous loop after you
selectContinue in the Applications Choices dialog box. Follow these steps to solve this problem:

Step 1 Exit the installation program by pressikgor Alt +Esc
Step 2 Restart the CiscoRemote installation process.

Step 3 Install your preferred applications from the Applications Choices dialog box, except for
Netscape.

Note This problem is resolved in CiscoRemote 1.0 (2).

Modem Connections

Some modems are not identified by the Discover feature in the Modem Port Setup dialog box. For
example, the installation program may hang when an unrecognized modem is attached to the PC,
such as the US Robotics Courier and Sportster modems. To work around this problem, manually
select your modem from the dropvdo modem window and clic®K. This problem is resobd in
CiscoRemote 1.0 (2).

The chapter “Getting Started with PPP/SLIP Connect” is updated in CiscoRemote 1.0 (2). Within
this chapterestablishing connections to remote ratg through your PG’COM port and modem

is explained and new functionality is documented. Refer to the section “Updates to CiscoRemote
Documentation,” in this release note, for more information.

Documentation
Each of the following documents are located on the CiscoRemote CD-ROM:

® CiscoRemote User Guidalso available in printed format)
® CiscoRemote Administrator Manual

® Netscape Manual

® Powerburst Manual

® Timbuktu Manual

® FEudora Manual
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Viewing Online Documentation

To view the documents from the CiscoRemote CD-ROM, load the CD-ROM in your system’s
CD-ROM drive and follow this procedure:

Step1 Open the Netscape browser.
Step 2 From the File menu, choo§pen File.
Step 3 Select the drive containing the CiscoRemote CD.

Step 4 From the CD-ROM's root directory, open the file CONTENTS.HTM, which is the
CiscoRemote CD-ROM directory.

Step5 Select the manual that yowant to viev. You can bravse through the documentation using
the scroll bar, hyperk links, and thé3ack andForward features in the Netscape toolbar

You can also access CiscoRemote technical documentation on the World Wide Web:
http://lwww.cisco.com

Updates to CiscoRemote Documentation
The following two chapters have been updated in the CiscoRemote 1.0 documentation:

® “Getting Started with PPP/SLIP Connect” in thiscoRemote Administrator Manual
® “Eudora Light Electronic Mail Client” in th€iscoRemote User Guide

Within the chapter “Getting Started with PPP/SLIP Connect,” the process of establishing
connections to remote networks through your PC’s COM port and modem is explained and new
functionality is documented. The chapter “Eudora Light Electronic Mail Client” contains additional
information on configuring Eudora Light and sending a message.

Testing Connections in the Cisco Dial-in Testbed

Through tvo 14.4k \/32bis lines, you can test CiscoRemote &gifying asynchronous connections
to network hosts and Powerburst agents through a Cisco access server, which provides an EXEC
prompt and support for the following protocols:

® AppleTalk Remote Access Protocol (ARAP)

® Internetwork Packet Exchange (IPX) over PPP

® Password Authentication Protocol (PAP) authentication

® SLIP

® [P over PPP

The following three network hosts and two Powerburst agents are available in the testbed:
® Linux (Unix) machine for IP testing

® Windows NT server for NetBIOS over NetBEUI, IPX, TCP/IP, and WINS testing

® Novell server for IPX testing

® Powerburst agent for Novell NetWare 3.x and 4.x testing

® Powerburst agent for Microsoft NT testing
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How to Use the Testbed

Once You Start

The modems can be reached by calling +1 408 526 8928, which is a telephone rotary group of tw
modems. The lines are configured to autoselect PPP and ARAP, which means you can start
transmitting PPP or ARAP immediately. The login for the access server is usermameiith
passwordisco . The lines are configured for PPRAPauthentication. & can use autoseleci®

or you can log in manually though the username and password prompts and start PPP or SLIP.

If your PPP client supports PAP, use the userngstie and the passworgkco . Otherwise, skip
through the username and pasetprompts by entering the retureyk(CR and issue the command
ppp default for PPP oslip default for SLIP at the command prompd (

If you are testing the Powerburst remote node accelerator, set your Powerburst agent name to
CISCO_AGENT under the Advanced Options menu in the Powerburst control panel.

Depending on which protocols you are running inside CiscoRemote, you have access to servers in
the testbed. Log in to each serwith the usernamsco and the passwdcisco . Refer to &ble 2
for a list of available server connections.

Table 2  Available Server Connections

Protocols Running in CiscoRemote Available Servers in Testbed

IPX You canaccess the server called CISCO-RULES.

IP You canTelnet, FTB, or TFTF to 172.16.24.117,
which is a LINUX machine called publinux.

NetBIOS over IP Point your WINS server to 172.16.24.118. This will enable

you to mount the machine DIALIN-TEST in domain
WORKGROUP. You can connect a network drive to
\\DIALIN-TEST. Browsing will not work, unless you
statically configure your browse master as
“DIALIN-TEST.”

NetBIOS over IPX The Windows NT server is configured to bidirectionally
forward IPX broadcasts.

NetBIOS over NetBEUI, Xremote, LATamd These protocols are not supported in the testbed.
TN3270

1. File Transfer Protocol (FTP)
2. Trivial File Transfer Protocol (TFTP)
3. Local-area transport

Note The addresses assigned by the dial-in pool for CiscoRemote users are 172.16.24.125 and
172.16.24.126.
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Cisco 2500 Access Server Configuration Examples

Use the following sample configuration of a Cisco 2500 access server to help you configure your
access seer or routerThe exclamation points (!) at the gmning of a line indicate a comment line.

IFor Appletalk (over PPP only, not ARAP)
appletalk client-mode

IFor ARAP
arap network 668 NeverNeverLand

IFor IPX
ipx routing

ICreate a loopback interface if you want all IPX users on a single net
interface LoopbackO

no ip address

ipx network CF

linterface EthernetO

IFor IP
ip address 172.16.24.116 255.255.255.0

IFor appletalk
appletalk cable-range 660-660
appletalk zone NeverNeverLand

IFor IPX
ipx network CE

IFor NETBIOS over IPX only
ipx type-20-propagation

linterface Group-Asyncl
!In General
encapsulation ppp

no keepalive

async mode interactive

ISelect a range of lines
group-range 1 16

IFor IP: Use addresses from the ethernet interface network.
ip unnumbered EthernetO
ip tcp header-compression passive

IFor IPX only: Assign all dialin IPX to the network on loop 0 (CF)
ipx ppp-client Loopback0

IFor NETBIOS over IPX only
ipx type-20-propagation

IFor IP. Pick IP addresses for the remote caller from this local pool.
peer default ip address pool default

IFor all. Demand a password by PAP if not logged in
ppp authentication pap if-needed

IPAP password table
username cisco password cisco

Iset a range of addresses from the ETHERNET not in use

ip local pool default 172.16.24.125 172.16.24.141
line 116
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ITime out if idle for 20 minutes
session-timeout 20

IPresent a username prompt if they don't speak PPP right away.
login local

IModem signal handling for CD and DTR
modem InOut

IAutoselect: Detect ARAP and PPP packets at the Username: prompt.
autoselect arap

autoselect during-login

autoselect ppp

IFor Appletalk (ARAP).
arap enable
arap noguest

IDisallow reverse connection (add only after modems are configured)
transport input none

1Set to maximum DTE speed of modem (typically 115200 for V.34)
rxspeed 115200
txspeed 115200

IUse RTS/CTS for flowcontrol
flowcontrol hardware

The following example displays dial-in IP and IPX users on their own subnet.

ICreate a loopback interface representing the "dial in network."
interface LoopbackO

ip address 172.16.25.1 255.255.255.0

ipx network CF

linterface EthernetO
IFor IP
ip address 172.16.24.116 255.255.255.0

IFor appletalk
appletalk cable-range 660-660
appletalk zone NeverNeverLand

IFor IPX
ipx network CE

IFor NETBIOS over IPX only
ipx type-20-propagation

linterface Group-Asyncl
lIn General
encapsulation ppp

no keepalive

async mode interactive

ISelect a range of lines
group-range 1 16

IFor IP: Use addresses from the loopback interface network.

ip unnumbered Loopback0

ip tcp header-compression passive

IFor IPX only: Assign all dialin IPX to the network on loop 0 (CF)
ipx ppp-client Loopback0
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IFor NETBIOS over IPX only
ipx type-20-propagation

IFor IP. Pick IP addresses for the remote caller from this local pool.
peer default ip address pool default

IFor all. Demand a password by PAP if not logged in
ppp authentication pap if-needed

IPAP password table
username cisco password cisco

Iset a range of addresses from the loopback interface range.
ip local pool default 172.16.25.2 172.16.25.18

Note If either PAP or Challenge Handshake Authentication Protocol (CHAP) is configured in
CiscoRemote, the passmds in CiscoRemote and the accessesanust be identical, becauseythe
are case-sensitive.

Cisco Information Online (CIO)

You can access additional technical documentation on CiscoRemote from Cisco Information Online,
which is Cisco Systems’ primary, real-time support channel. Available 24 hours a day, 7 days a
week, ClO provides a wealth of standard and value-added services to Cisco’s customers and
business partners. CIO services include product information, software updates, release notes,
technical tips, the Bug Navigator, configuration notes, brochures, descriptions of service offerings,
and download access to public and authorized files.

CIlO serves a wide variety of users through two interfaces that are updated and enhanced
simultaneously—a charactbased ersion and a multimediavsion that resides on theovid Wide
Web (WWW). The character-based CIO (called “CIO Classic”) supports Zmodem, Kermit,
Xmodem, FTP, Internet e-mail, and fax download options, and is excellent for quick access to
information over lower bandwidths. The WWW version of CIO provides richly formatted
documents with photographs, figures, graphics, and video, as well as hyperlinks to related
information.

You can access CIO in the following ways:
®* WWW: http://www.cisco.com
[ ]

Telnet: cio.cisco.com

® Modem: From North America, 408 526-8070; from Europe, 33 1 64 46 40 82. Use thvinipllo
terminal settings: VT100, N81, up to 14.4 kbps.

For a copy of CIO’s Frequently Asked Questions (FAQ), cortaatlp@cisco.com . For
additional information, contaeto-team@cisco.com

Note If you are a network administrator and need personal technical assistance with a Cisco
product that is under warranty or covered by a maintenance contract, contact the Cisco Technical
Assistance Center (TAC) at 800 553-2447, 408 526-7208®tisco.com . To obtain general
information about Cisco Systems, Cisco products, or upgrades, contact 800 553-6387,

408 526-7208, ots-rep@cisco.com
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